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Of  
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Objective 

 

General Objective 

To identify the content of website 

Specific Objectives 

By the end of this lesson, the students will be able to 

 Identify the concept of Website, Home Page, and Webpage. 

 Deduce that the website has more than webpage. 

 Deduce the content of webpage [Text, image, video, hyperlink,..etc] 

 Identify the concept of static webpage. 

 Identify the concept of Interactive webpage,. 
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A Website is a webpage or more, connected with each other, with a 

certain name and Web address. The website can be visited on the 

computer or the cell phone.  

  

 

 
Cooperating with your classmates and with the help of the teacher: 
-Define the website. 
-Define the Home page . 
-Define the webpage. 
-Deduce that the website consists of more than a webpage. 

-Upload the website of the ministry of Education http://www.moe.gov.eg 
The teacher discusses with the students the following: 
Website – Home page – Webpage  
 
 
 
 
 
 
 
 
 

 
 
 

 
 

 
 
 

Home page 

Web pages 

WebSites 

Activity 

http://www.moe.gov.eg/
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MOE Website 
 
 
 
 
 
 

Ministry of Education Website 
 

 
Website: 

It is a site on the internet that consists of a webpage or more, it is 
visited through a certain web address. 

Web Page: 
It is a document with electronic content on the internet which can be 
shown through a web browser. 

Home Page: 
It is the opening page in the website through which other pages can 
be visited. 

 
 
 
 
 
 
 
 
 
 
 

Homepage 

Web pages 
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Cooperating with your classmates and with the help of the teacher: 
- Deduce the components of the webpage [ text- images- sound- video-hyperlinks, 
etc] 
- Deduce the types of Data shown on the web page. 
-Deduce the components of the different types of web pages. 

 
 
 

 
 

 

 

 

 

 

 

 

The components of the web page are: images, text, audio , video and 

hyperlink 
 

 

 Components of the web page: 

  The web page inculds texts , images, audio files, videos and hyperlinks. 

 

 

 

 

images 

text 

video 

hyperlink 

Web page components 

Activity 
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Cooperating with your 

classmates and with the 

help of the teacher : 

-open a website and 

roam its pages 

-identify the Static web 

page components, which 

don’t change each time 

you visit the page. It can 

have texts, images, 

sound or video clips, 

which can’t be modified. 
 

 

 

 

 

 Static Web Page: 
The content of these pages is previously prepared by the page 
developer. The content doesn’t change and can’t be edited by the 
visitor. It is designed by HTML code I designing such pages. We will see 
how to design these pages later by using HTML.  

 
 
 
 
 
 

 “Static Web Page” 

 

Static and interactive web pages 

 

Activity 
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-  

 

 

The interactive web pages 
- Dear student, The e-learning page on the 

Ministry of Education website requires 

deciding the stage and school term to be 

able to see the curriculum or the text book 

of a certain school year. 

- Fill in the form, click “search” and write 

down notes on what happens.  
 

 

-The contact us page on the Ministry of 

Education Website requires filling some 

information. 

- Fill in the required information and click 

sign in. 

- Type your notes of what you see. 

 

 

 
 

 

 

Interactive web pages 
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 Interactive Web Page: 
It is a webpage that has a content allowing the visitors to interact 

with and manipulate. This type is designed by HTML , JavaScript, PHP 
and others. 

 
  

 
 

 

Cooperating with your classmates and with the help of the teacher, open 

websites like  

-  http://www.sis.gov.eg  

- http://www.ahram.org.eg 

Identify the homepage. 

-Identify the content of the website [text, images, video or 

hyperlinks] 

-Identify the static web page. 

-identify the interactive webpage. 

  

 

  

Exercise 

 
 
 

http://www.sis.gov.eg/
http://www.ahram.org.eg/
http://www.ahram.org.eg/
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Remember: 

Website: 

It is a site on the internet that consists of a webpage or more, it is 
visited through a certain web address. 

Web Page: 

It is a document with electronic content on the internet which can be 
shown through a web browser. 

Home Page: 

It is the opening page in the website through which other pages can 
be visited 

Static Webpage: 

The content of these pages is previously prepared by the page 
developer. The content doesn’t change and can’t be edited by the visitor 
. It is designed by HTML code 

Interactive Webpage: 

It is a webpage that has a content allowing the visitors to interact with 
and manipulate. This type is designed by HTML , JavaScript , PHP  and 
others. 
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Prepare for the next lesson 

 

What are the stages to design and create a website? 
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Question 1 : Complete the following: 

- The website is ………………………………………. 
- The webpage is………………………………………. 
- The Homepage is ……………………………………. 
- The static webpage is …………………………….. 
-The interactive webpage is………………………… 
Question 2  

 Open this website http://www.egynews.net 

-Identify the homepage. 

- State the contents of the homepage [ text, images, video, hyperlinks,…] 

-What type is the homepage: static or interactive ? 

- Go through the site pages and identify the page contents, then decide if  

it is a static or an interactive web page.  

 

 

 

 

 

 

 

 

 

Exercises 

 

 

 

http://www.egynews.net/
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Stages of designing and creating 

a Website 
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Designing and creating a website goes through stages that can be set 

here: 

- The first stage: planning to create a website. 

- The second stage: design the web pages. 

-The third stage: prepare and develop the web pages. 

-The fourth stages: implement the web pages. 

- The fifth stage: publish the website on the internet 

 
 

Stages of designing and creating a website 

 

 

 

Plan 

Design 

Prepare 
and 

Develop 
Implement 

Publish 

Stages of designing and creating a website 
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In this stage, we draw a simple diagram of the web pages of the 

website, the homepage and the connected pages 

- Decide the information and data to be included as data or service 

according to the need. 

 

 

 

Cooperating with your classmates and with the help of the teacher, plan a website 

with the following  

 

- Title and subject to be dealt with in the website. 

-The number of pages [the homepage and the web pages] 

- Plan the diagram of the homepage and other web pages, decide the information 

and data to be shown. 

 

 

 

This stage is the most important one as we design the format and 

shape of the homepage and other pages. The different format types are 

designed, the colour, the background, the font size and type, place of 

putting text, images and video clips and decide the different hyperlinks 

inside the same page and connected with other pages in the website. 

 

 

 

The First Stage: Planning 

 

The Second Stage: Design the web page  

 

Activity 
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Cooperating with your classmates and with the help of the 

teacher: 

- Design the shape of the home page and the other 

web pages. 

- Design the hyperlinks. 

- Design the places to put text, images and video 

clips on the page. 

 

 

 

 

 

 

 
 

 

"A diagram for designing a website   “ My School مدرستي   

Homepage 

Vision and 
Mission 

Photo Album About school 

Activity 
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This stage consists of important steps which are as follows: 

- Prepare the text which will be added to the page using a text editor 

program and save it in a folder. 

-Prepare the image files and save them in a folder. 

-Prepare the video and sound files and save them in a folder. Later on 

we will know how to create and edit these files. 

 

 

1-prepare the text files: 
Cooperating with your classmates and with the help of the 

teacher: 
-Search for the suitable text files to be used in the web 
page. 
-Select the needed text files for each web page. The 
search for the text files can be done through the 
internet or asking the school administration about 
information like: 
  

  
 
 
 
  
 

 
 
 
 

The Third stage: Prepare and develop 

 

When did the school open? 

The school address. 

The telephone number. 

Vision and mission of the school. 

Activity 
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2-Prepare the image files 
 
 

 
 
Cooperating with your classmates and with the help of the teacher: 
-take photos of the school, the classes, the playground and labs. 
- collect the photos of school activities and competitions, photos of certificates 
and prizes which the school won. 
- save the images in a folder in a drive 

  
 
 
 
 
 
 

 
 
 

 
 
 

 

 
 

 
 
 

Different school activities 

 

 

 

 

Activity 
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-Take photos using a digital camera or a mobile phone 

camera. 

- Collect the images about the activities which the 

students do. 

- collect the images of the school competitions at school or at the educational 

administration [ Idara} 
-Collect images about the certificates and prizes which the school won. 

-Input these images to the computer using a scanner, mobile data cable or any 

other way. Create a folder “ Pro1” to save the images in it. 

 

 
 
 

 
 

 

 
 

- Cooperating with your classmates and with the help of the teacher: 
- identify some image file types. 
-Search the internet for images with the extension JPG- GIF-BMP-PNG and discuss 
the difference between each type. 

 

3-Prepare the sound and video files: 

This will be discussed in the following lessons. 

 

 

 

 

 

 

Exercise 

 
 
 



 

 
24 

Ministry Of Education 

Computer and Information Technology 

 

 

 
 

 

This is the stage when we change the paper design into web page to be 

shown and visited on the internet with an internet browser program. 

- Input the data, text, images, nd videos and so on. 

- Create the necessary hyperlinks to connect the different pages and 

facilitate browsing the site. This is done using HTML codes.  
 

 

 

-In this stage, a web address is taken and the storage capacity is decided 

to save on one of the servers and publish the site on the internet  

 A suggested diagram of the website “My School” مدرستي    "  

 

 

 

 

 

 

 

 

 

 

 

 

 

Stage Four: Implementation 

Stage five: Publish on the internet  

 

My school 

Home page- About school- Photo 

Album-Vision and mission- Contact us 
 بنا

 

 

 

 

 

 

 

Photo Album 

 

 

 

 

 

 

 

 

Vision and Mission 

Vision:to prepare a 

distinguished student able to.. 

 

 

 

 

 

 

About School 
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Remember  

Designing and creating websites has many stages: 
Stage one : planning 
- Set up a simple diagram on paper for the homepage and the site 
pages. 
-Decide the data and information to be used in the webpage. 

Stage two :design the format and shape of the homepage and web 
pages 
Design the page format  
Select the background colour. 
-Select the places to add text files, images, videos and sound files. 
-Create the hyperlinks connecting the pages . 
Stage Three : Prepare and develop 

This stage consists of important steps which are as follows: 

- Prepare the text which will be added to the page using a text editor program 

and save it in a folder. 

-Prepare the image files and save them in a folder. 

-Prepare the video and audio files and save them in a folder. Later on. 

Stage Four : Implementation 
This is done using a programming language and HTML codes: 

- Convert the design into webpage. 

- Input the data and files. 

- Create the hyperlinks. 
Stage Five : Publish the website on the internet 
 Choose a title, select a web address, decide the storage capacity on a server and 
publish on the internet. 
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Question One: Complete: 
First, designing and creating a website goes through 
stages which are: 

1. ………………………………………………. 
2. ………………………………………………. 
3. ………………………………………………. 
4. ………………………………………………. 
5. ………………………………………………. 

Second, in the stage of implementation, we 

1. ............................................................. 

2. ............................................................ 

3. ............................................................ 
 

 

 

 

 

  

Exercises 
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In Stage three in designing and creating a website, we 
prepare audio files. 

How can we create a sound file? 
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Objectives 

General objectives 

Create and process audio files through one of the related 

programs.  

By the end of this lesson, students will be able to: 

 identify creating and audio processing program  

 setup and prepare (data / software components and material) to 

create the audio 

 Use Audacity program to create and process audio files. 

 Edit (Add Effect / cut and paste / delete) in the audio clips. 

 Identify  appropriate extensions of audio files. 
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There are many programs that are used on dealing with audio files. 

These programs help to process audio files in an easy and proper way. 

They are software programs that enable the user to create and process 

audio files. They contain tools that creating and processing audio files. 

Creating an audio file 

You can create an audio file containing audio clips and the words 

required as well as adding different effects on the audio and specifically 

on a track, and then save the audio in a file. To create an audio file, we 

need a sound processing software. 

We are going to create an audio with the name "my school" with a 

comment audio to a project or be included in the video clip for the 

school. 

Suggest an edit 
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Cooperating with your classmates and with the help of the teacher, prepare for 

the required steps to create an audio file to a school, as follows: 

1- Preparing for collecting data about school, as follows: 

 School name: ... Educational department: ... governorate... : 

 School trips and various activities provided by.................. : 

 The competitions the school shared in………………….  

 The ranks won in those competitions  :...........  

 Recognitions obtained by the school  ............  

 The summer activities the school provides …….. 

 School trips and various activities provided by the school…… 

- Type the data collected about the school in one of the text editing 

programs and edit them. 

Save the text data in a text file. 
 

2-Preparation and processing of software 

and hardware components: 

Through the school computer lab and 

with the help of your teacher, students do 

the following: 

- Make sure you install a program and 

create audio processing on computers 

laboratory. 

Firstly: the setup and processing to create an audio 

file stage: 

Suggest an edit 

 Activity 
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.- Make sure your microphone is plugged to your 

computer. 

 
 

- Setup and preparing to create a audio file stage include: 

-  All the data that will be audio recorded. 

- Make sure of the software components (install one of the 

programs of creating and audio processing on computers in 

the lab.) 

- Make sure of the software components (install one of the 

programs of creating and audio processing on computers in 

the lab.) 

- Ensure the hardware components (connecting the microphone 

"Mic" to a computer.) 
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Cooperating with your classmates and with the help of the teacher, create 

an audio file from their school through one of the programs of creating 

and audio processing as follows: 

- Load one of the programs of creating and audio processing. 

- Audio recording through the program. 

- Read the text data already prepared and inserted to the computer 

using a microphone as an input unit. 

- Turn on the sound after the completion of recording and listen to it 

through headphones. 

Steps to implement activity: 

- Using the "Audacity" program to create and audio processing which is 

an open-source software, a program that can be run on different 

operating systems like (Windows –Linux( 

You can download the program through the website: 

http://audacity.sourceforge.net/ 
 

Secondly, the implementation stag 

Activity 

http://audacity.sourceforge.net/


 

 
34 

Ministry Of Education 

Computer and Information Technology 

 

Audacity Interface (a program for creating and processing audio) 

- To start voice recording through the program, click the Record button 

where the 

program 

becomes in the 

audio recording 

mode. 

- Read the data 

collected for the school in the text file using the Mic "microphone" as a 

unit input. 

The Program Timeline to make sound appear  

- To complete entering audio data,click "Stop" button in the program. 

- To listen to the sound that has been entering click "Play" button       in 

the program, listening to the sound through the speakers. 

 

 

 

 

"Transport" 

menu 

to record sound 
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 The implementation Stage to create a sound file includes:  

- Load a set up and sound processing software. 

-Click " Record " button  to record voice. 

Insert text data by using the microphone. 

To finish recording, click " stop" 

To listen to the audio Through the speakers, click " play " 

To listen to the audio Through the speakers, click " play " 
 

 

 

 

 

 

 

After listening to the audio that was recorded there may be a need 

to After listening to the audio that was recorded there may be a need to 

add an effect on the sound (or audio) clip, delete or cut part of the 

sound (audio clip) and paste it somewhere else in the audio clips. Delete 

or cut part of the sound (audio clip) and paste it somewhere else in the 

audio clips. 

  

 

 

 

 

 

 

Thirdly, modifying the sound (or audio clip): 
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Adding an effect on audio clip: 

 

 

Cooperating with your classmates and with the help of the teacher, add an 

effect on voice or sound clip as follows: 

- Audio playback by clicking " Play button" and listen to it. 

- Select the desired audio clip added to effect him by clicking and dragging on the 

desired sound indicator reading at the time the tape. 

 
 

 

Program timeline the with the sound 

- From "Effect menu, select one of the desired effects. 

- Rerun the audio by clicking" play button" and listen to the audio clip 

after adding the effect. 
 

 

 

To add other effects to the audio file or one of the audio clips. 

- Cooperating with your classmates and with the help of the teacher, identify the 

audio clip and add one effect like "Repeat." 

- Play the sound file and listen to it. 

-deduce what this effect does. 

- Notice that when we choose “Repeat “ effect, the selected clip is 

repeated. 

Activity 

Read 

pointer 

Practice 
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To add other effects to one of the audio clips. 

 Cooperating with your classmates and with the help of the teacher, 

identify the audio clip and add one of the effects like "Reverse." 

-Play back the audio and listen to it and try to conclude the purpose of 

this effect. 

Notice: On choosing "Reverse" effect, the beginning of audio is reversed 

with the of the end section. 

 

 

Cooperating with your classmates and with the help of the teacher: 

- select the rest of the effects and add them to a sound clips. 

-  play back the audio and listen to it and try to conclude the purpose of 

each effect. 

 
 

Add an effect on the audio clip: 

- Select the desired audio clip added to effect it by clicking 

and dragging on the desired sound indicator reading at the 

time the timeline. 

From " effect" menu, select one of the desired changes  

 

 

 

 

 

Practice 

 
 
 

Practice 
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2-Cut and paste an audio clip 

 

 

Cooperating with your classmates and with the help of the teacher: 

- cut the portion of the audio and paste it in another place among the 

audio clips. 

  

- Select the desired audio clip you want to cut, from the Edit menu 

select "Cut". 
 

 

- Move the pointer on the timeline to the desired place to paste the 

audio clip, from the Edit menu select" Paste". 

- Rerun the audio by clicking the play button and listen to it. 
 

Cut and paste an audio clip 

Select the audio clip you want to cut. 

From ' Edit menu " select " Cut" 

- Move the pointer on the timeline to the desired place to paste the 

audio clip, ." 

From the Edit menu select" Paste" 

 

 

 

Activity 
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3-Delete a section of the audio. 

 

 

Cooperating with your classmates and with the help of the teacher, delete a part 

of the sound audio clip as follows: 

Select the audio section you want to delete. 

Press ” Delete" from Keyboard to delete the audio section you selected. 

 

To delete an audio section:  

Select the audio section you want to delete. 

Press " Delete" from the keyboard. 

 

 

 

 

 

 

 

 

 

 

 

Activity 
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Cooperating with your classmates and with the help of the teacher: 

export an audio file with an appropriate extension:  

To export an audio from " file menu", select "Export Audio" : 

Select the appropriate extension of the audio file:  

Save the audio file in " Pro 1" folder. 

 

To export an audio file with An appropriate extension: 
From the File menu, select "Export Audio" 

Select the appropriate extension of the audio file. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fourthly: Export an audio file with an appropriate  

extension. 

 

Activity 
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There are different types of the extension of audio files such as WAV, 

MP3, ... They differ in the quality and purity of sound and storage space.  

According to need, we use the proper file extension. 

 

 

Cooperating with your classmates and with the help of the teacher do the 

following: 

 Identify different audio file extensions when saving as an audio file. 

 Save an audio file with WAV extension, and save the file again with 

MP3 extension. 

- Comparison of audio files with the extension WAV and MP3 in terms 

of: 

 File size. 

 Sound clarity , purity and quality  .........................  

 Through the Internet search for the types of sound with different 

extensions files. 

- Collect the information on the types of different extensions of audio 

files in a text program coordinators. 

 The teacher discusses search results with students. 

Notes: 

- The sound of a WAV file extension is characterized by the sound 

quality and clarity, it has a large storage capacity, so it is not 

appropriate for publication via websites. 

Types of audio file extensions 
 

 Practice؛
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- Audio MP3 file , the sound is of less purity, 

compared with the file with WAV extension, has less storage capacity, 

so it is appropriate for publication via websites. 
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  Remember that 

To create an audio file, you should do the following: 

First : setup and processing: 

 All the data that it will be recorded. 

 Hard and software components 

 Make sure there is a program to create and edit sound file that 

works properly. 

 The Mic and speakers are connected to the computer. 

Second : Implementation 

 Start a program that deals with sound files. 

 Record the sound using the program. 

 Use the Mic to input the sound 

 Press “Stop “ to finish inputting the sound. 

 Hear the sound clip using the speakers by pressing “Play” button. 

Third : Edit the sound file 

 Add effect  

 Cut and paste a file  

 Delete a sound clip. 

Fourth : Export the sound file  

 Export the sound file with appropriate extension 
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The first question: Complete the following:: 

To create an audio file, do the following:  

Firstly: ………………………………………… 

Secondly: ……………………………………. 

Thirdly: ……………………………………….. 

Fourthly: ……………………………………… 

 

Second question: Perform the following steps to create and export the 

audio file: 

- Choose a topic of study from school subjects 

- Collect information on the academic subject. 

- Load one of the programs of creating and edit an  audio file   

- Create a sound file  

- Export the file with the appropriate extension 
 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise 
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Prepare for the next lesson 

In Stage three in designing and creating websites, 
there is preparing and creating video files. 

 

How can we create a video file? 
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Creating and Editing 

Video Files
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Objectives 

General Objective: 

Creating and editing a video file using a video editing 

program  

Behavioural Objectives: By the end of this lesson, a student will 

be able to: 

 Identify some video editing program. 

 Import video editing program files (sound/images). 

 Create video captions using the program. 

 Edit video segments.  

 Save video file project. 

 Add (effects, transition effects, text) to video segments. 

 Export video to a file with suitable extension. 

  



 

 
48 

Ministry Of Education 

Computer and Information Technology 

 

 
 

 
 

Creating and editing video programs are the ones that enable the user 

to create and edit video files. This is done through tools and effects that 

help the user create and edit video clips easily and fast.  

TO edit a video of a group of images taken, or edit video clips 

recorded by a video cam or a webcam, we must use a program through 

which the video is cut into segments of still clips. Moving these shots in 

a fixed speed makes them feel animated. Then these shots become easy 

to edit its content and in this way the video content can be edited. 

There are many programs that can be used in creating and editing video 

files like: “Kdenlive” and “OpenShot”, which are open source and free to 

use and easy to operate with Linux and Ms. Windows. There is also 

“Movie Maker” which runs in Windows. These programs and other ones 

can be downloaded online. 

  

  

 

 

 

 

 

 

 

 

 

Creating and Processing Video File Programs 
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Cooperating with your classmates and with the help of the teacher, download one 

of creating and editing video programs and identify its interface. 

 Procedures of Activity: 
-Download a video editing program .”OpenShot” will be used and 

you can get it on http://www.openshot.org 

   

OpenShot Video Editor is used to create and edit videos. Videos can be 

created through images collected. OpenShot Video Editor enables the 

user to make a high quality video with images, backgrounds and 

inserting audio files easily. The interface is easy to use to add images 

and sound easily, with video effects, transitions and even texts to the 

segment. The program will be used to make a video about school 

activities. 

 

  

Download Video Program and Identify Its Interface 

 

Activity 

OpenShot 

http://www.openshot.org/
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 Interface"OpenShot" 
 

 

The interface consists of  

1- Main Toolbar. 

2- Project Files. 

3- Function Tab (Move – Images-Audio files) 

4- Preview Window. 

5- Edit Toolbar. 

6- Zoom Slider. 

7- Play head/Ruler. 

8- Timeline. 

 

 

1 

2 

3 

5 

4 

7 

8 

6 
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Cooperating with your classmates and with the help of the teacher: 

- Similarities and differences between the OpenShot Interface and other 

programs they used before. 

-Use Help to find new information about the program. 
 

Program Timeline: 

 

 

1- Ruler (to show the time length on the timeline). 

2-Play Head (reads the current clip on the timeline to show in Preview 

Window). 

3- Current Clip (image, sound or video). 

4-Tracks (They are similar to Layers where images, sounds or video 

caption clip is put on the track. Unlimited number of tracks can be used 

in the project. Notice that the higher track has the priority to read to 

show the video, then the lower and so on.) 

  

 

 

 

1 
2 

4 

3 

Exercise 
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Cooperating with your classmates and with the help of the teacher , create 

video clips about their school, including pictures of the school building, labs, 
playgrounds, activities, competitions and the most important trophies and prizes. 

Steps of the activity 
To create a video about the school easily , follow the following steps: 

1- Import images to the program. 

2- Put the images in order on the program timeline 

3- Import a sound file to the program. 

4- Preview the video.  

1-Import image files into the program: 

- Click Import files icon + in the Main Toolbar to add the images.( You 

can import files from File, then Import Files). 

- Import images from the “ مدرستتي  ” folder, to show in the “Project Files 

tab in the program interface. 

 

 
 

 

Create Video Clips 

Activity 
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2-Put Images in order on the Timeline: 
To create Video clips, the images are put in order on the video timeline. 

 

 

"Timeline  
- Drag and drop the images in the “Project Files” window. 

-Put all the images in Track path and put them in the suitable order. 

  

 

 

 

 

 

 
 

 

 

Import 

Button 
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- When putting images in Track , they become a (Video Clip) and appear in the 

Video Preview. 

- Put the images in order in Tracks on the Timeline. 

  

3- Import Sound files into the program: 

- To make the video clip more attractive and effective, we add music or sound 

comment. 

- To add sound file, click Add File icon + on the Main Toolbar and add the 

sound file to appear in “Project Files” tab. 
 

 

 

 

- Drag and drop the sound sign to insert in one track. 

 

 
 

Sound 

File 
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4-Preview the video 

-To preview the video, click the Play icon     in the Preview 

window. 
 

 

 

 

 

 

 

 

 

 

 

 

 

To create a video clip do the following:  

1- Import files ( images/ sound) into the program. 

2- Put images/sound on the program Timeline. 

3- Preview the video. 

 
 

 

- Cooperating with your classmates and with the help of the teacher, import 

files ( audio/ images) into the program. 

Students, in their notebooks or writing tools, the steps to follow to import 

files into the program.  

 Notes 

- To add a new Track, click the +Add Track icon on the Edit Toolbar. 

 

 

Play  

Exercise 
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-To change the order of the video clips (images/ sound) on the track, drag 

and drop and reorder them.  

-To set playing the sound file, drag and drop the sound on the track on the 

Timeline and put in its place. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add 

Track 
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To create video clips, we use images, sound files and text files; 

these all must be saved in one folder. All the previous files were saved 

in the folder “ Pro 1” to be able to go and edit ,delete or add later. How 

can we save a video project? 

 

 

 
 

Cooperating with your classmates and with the help of the teacher ,save the 

video project: 

Steps to follow 

To save the video project, do the following: 

-Save all the files (images, sound, text, etc) in one folder. 

-On the Main Toolbar, select “File”, then “Save Project As” 

-Name the Project “ sch”;all names must be in English. 

 -Define where to save in the folder “Pro1” 

-End the program. 

 -To continue the project, start the program, then open the “Pro1” 

folder, then open “sch” project. 

-Edit the video clip. 

  

  

 

 

 

 

  Save Project: 

Activity 
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Important Notes for the teacher to save the project: 

The teacher should do the following: 

During work in OpenShot in Ms Windows, and saving 

the project, notice that the “sch” file is unknown so it 

appears 

 -To make the file work in the OpenShot program, do 

“Association” as follows: 

 -right click on the “sch” file .Select Properties, change then more 

options. 

-Select : Look for another app on this PC.  

- The system will find the OpenShot application folder. 

-Select association to the executable file of the program. 

 

 

 

 

 

 

 

 

The “sch” file will appear like this 
 

 

 

 

 

Executable 

file  
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To save a video project, do the following: 

- Save all the used files,( images, sound, text…( in a specific folder. 

- From the Main Toolbar, select File, Save Project As 
- Name the project in English. 

 

 

 

 

 

 

 

 

 

After Previewing the Video, the clip may need some editing like Reorder 

the scenes, delete, increase the time, decrease the time or adjust the 

time to match the sound file length 

1-Control the play time of the Video Clip 

After previewing the video clip, the sound file time may be longer 

than the image show time. This appears in the Timeline which ends the 

images and the sound continues. This can be seen also in the clips on 

the timeline 

  

 

 

 
 

 

 

Edit Video Clips 
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-We can control the sound clip to end at the same time with the last 

image clip on the timeline 

 

 
 

"Timeline" 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The image clip 

time length on 

the timeline 

 The Sound file length on the timeline 

Play 

indicator 
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Cooperating with your classmates and with the help of the teacher, control the 

audio clip by limiting the time on the Timeline. 

 Steps of the Activity: 

-Move the play indicator, drag and drop the arrow ( or use the arrows 

on the keyboard) until it reaches the end of the last image on the 

timeline. 

  
 

 
 

 

-Put the mouse cursor on the Track, right click the mouse. 

-Select the Slice clip, then Keep left slide. 

-Students take notes of what happens in this selection. 
 

 

 

Control the time length for images and sound on the 
timeline 

Play 

Indicator 

Activity 
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- When moving the play indicator on the timeline, then select one track 

and select “Slice Clip”, the video clip splits at the indicator place and 

becomes two slides : right slide and left slide. 

  
 

 

 

-With the help of the teacher, the students make out the difference in 

the following: 

When selecting Slice Clip, the following appears: 

 - Keep Both slides 

- Keep left slide 

- Keep Right slide 

The students make out the difference in the three choices. 
 

 Notices: 

-Selecting Keep Both Slides, the clip splits into two slides and keep them 

both 

 
-When selecting Keep left Slide, the clip splits into two slides and keep 

the left slide only. 

  

 
 

Exercise 

 
 
 

Keep left 

Slide 

 
Keep Both 

Slides 
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-When selecting Keep right Slide, the clip splits into two slides and keep 

the right slide only. 
 

 
 

 

 

 

To control the time length of the video clip: 
-Define the time length of the clip on the timeline. 
-Drag and drop the head of the play indicator and move it 
till it goes to the right place on the timeline. 
-Right click the clip Track, a drop box appears: 
- Select Slice Clip to split the clip into two slides. 
-Keep Both Slides, the right and left slides are kept. 
-Keep the left slide. 
-Keep the right slide.   

  
 

  

Keep right 

slide 
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Add “Effects” to the video clip and control the time of this effect to 

show the clip in a certain way. 

  

 

Cooperating with your classmates and with the help of the teacher, add Effects to 

a video clip. 

 Steps to follow:  

Click “Effects” tab. 
  
 

 

 

 

 

 

 

 

 
 

 

Some effects appear. 

 

 

 

 

  

Add Effects to a Video Clip 

Effect 

tab 

Activity 
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Choose an effect. 

Drag and drop the effect to add it to the clip. 

  . 
 

 
 

- Preview the video 

- Students take notes to see what happens on the video clip. 

  

 

Effects 
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Notes: 

  
The Effect sign appears 

 

 

.To read the effect name put the cursor on the Effect sign 

 

 

 

 

- To delete the Effect, right click the effect signand select “Remove 

Effect” 

  

 

 
 
 

Add Effect to a video Clip: 
 - Click the Effects tab. 
- Drag and Drop an effect to add it to the clip. 
- The effect sign appears on the clip. 
- To read the effect name put the cursor on the effect sign. 
- To delete the effect, right click the effect sign and select “Remove 

Effect” 

 

 
 

 

 

 

 

 

 

Effect 

sign 

Effect 

Delete 

Effect 
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Cooperating with your classmates and with the help of the teacher, add 

Transitions to the video clip. 

 Steps to follow: 
- Click the “Transitions” tab. 

 

 
 

 

- Some transitions appear. 

 

 

 

 
 

 

 

 

Second: Add  Transitions to a Video Clip 

 

Transitions 

Activity 
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Drag and Drop one of the transitions to add to the video clip 
 

 
 

 

 

-The transition is put at the beginning or the end of the video clip. 
Control the Transition length by drag and drop it to increase or decrease the show 

time. 
-Preview the video. 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Drag and drop to 

control the 

transitions length. 
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With the help of the teacher, the students use Files", “ Effects” and “ Transition “ 

and know the difference . 

  
 

 

 

 

 

 

 

 

 
 

 

To add Transitions to a video clip: 

- Click the Transitions tab 

- Drag and drop one transition and add it to the clip. 

- Add a transition at the beginning and at the end of the clip. 

- Clip the transition time length by drag and drop it to increase or 

decrease it. 

  

The three 

tabs 

Exercise 
 
 



 

 
70 

Ministry Of Education 

Computer and Information Technology 

 

 

 
 

 

 

Cooperating with your classmates and with the help of the teacher, add text 

to a video clip. 

Steps to follow: 

- Select the text to add to the video. 

- Select the places to add the text to ( at the beginning, in the middle or 

at the end of the video) 

- From the menu Title, select Title, the dialog box: 

 1- “Select a template” 

2-“Change Font” 

3-“"Text Color” 

4- “Background Color" 

5- Save text in a file  

 

 

 
- The teacher discusses with the students the steps to fill in the dialogue 

box to add text. 

- Press Save to save the text in the project folder “Pro1”. 

 (4ورشة عمل )
 
 
 

Third : Add Text to a Video clip 

Activity 
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- Name the file in English. 

- The text file appears in the “Project Files”. 

  
 

-To add text to video clips, drag and drop the text file in the Project Files and add it 

to a track. 

  

To add text to a video clip: 
- From Title menu, select Title. 

- Fill in the dialog box. 
- Save text in a file “Save”. 
-Name the text file in English. 
- The text file is found in “Project Files”. 
- Add text file to the video clips by drag and drop the text file and add it to 
a track.  

 

  

Text File 
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 Notes: 

-The text can be added at the beginning, in the middle or at the end of the video 

clip. 

- Add a Track or more to add the text and other clips ( images or sound)  

- Reorder the video clip ( audio , images or text ) on the Track 
 

 
“Reorder the video clips” 

 

 

- With the help of the teacher, the students add another text file to the video as 

follows: 
 - Follow the steps mentioned above to create another text file with information 

about their school, like the Governorate, the Directorate and so on 

- Save the text file in the project folder “Pro1”. 

-Add text to the video clip as done before. 

- Reorder the video Clips. 

  

  

 

 

 

 

 

 

Exercise 

 
 
 

El-Sanya Prep School 

for Girls 

Cairo 

South Cairo Directorate 
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After finishing the project, putting all the needed scenes and 

editing through adding suitable Effects and Transitions, the project can 

be exported to a video file with a suitable extension. The program 

makes it easy to export in different extensions.  

  

 

 

Cooperating with your classmates and with the help of the teacher, export the 

video to a file. 

Steps to follow 

-Press Export Video     in the Main Toolbar, or File, then Export 

video.  

  
 

A dialogue box of Export Video appears. 

-Name the file to save “File Name”. 

-Select the path to save in. 

- Select the extension to the “Target “video file. 

 -Decide the file quality level ( High quality – Medium quality – Low 

quality) 

-Press “Export Video “  

Export a Video Clip to file  

Activity 

Export 

Video 
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"Export Video Dialog Box ""  

 

 

 

 

 

 

 

 

 

 

 

 

 

“Play the Video “ 
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To export a video to a file with suitable extension: 

- Press "Export Video". 

- In the Dialog box of “Export Video", select the following: 

- “File Name”. 

-Folder Path. 

   - Extension of the Target video File. 

   - Decide the Quality level. 

   -Export the video by pressing “Export Video”, 

 

 

 

 
- There are different types of Video files with different extensions. 

They are different in size, quality and clarity. The extension of the video 

is decided according to the usage. 

  
 

- Cooperating with your classmates and with the help of the teacher, serach the 

internet for: 

-Different video types and usage. 

- The difference between different extensions, MP4, AVI,…, according to 

size, quality and clarity. 
 

 

 

 

 

Types of Video Files with different Extensions 

Exercise 
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Remember 

To Create a video file do the following:  

- Import images and sound files into the program. 

- Reorder the video clip on the Timeline of the program. 

Save Project: 

- Create a  Project Folder and name it in English, on one of the drives. 

- Put all the files, sound, images, etc., in the project folder. 

- Save the Project file and name it in English from the Main Tolbar , File, 

Save Project As 

- Save the project file in the Project Folder. 

Edit the Video Clips by  

- Control the length of the video clip time. 

- Add Effects to the video clip. 

- Add Transitions to the clip. 

- Add text to the clip by : 

- From Title, select Title and fill in the Dialog Box 

- Save the text in a file ( Name the text file in English) 

- The text file appears in the “Project Files”; then add the text file to the 

Video clip by drag and drop the text file and add it to a Track. 

Export the video to a file with a suitable extension: 

-There are different types of video files with different extensions like AVI, 

MP4 and so on. 
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Question 1 : Complete the following 

The Program Interface consists of the following 

 

 

 

 

 

 

 

 

 

 

 

 

1-…………………………………………….. 

2-…………………………………………….. 

3-……………………………………………… 
4-………………………………………………. 
5-………………………………………………. 
6-………………………………………………. 
7-………………………………………………. 

8-………………………………………………. 

 

Exercises 

 

 

 

1 

2 

3 

5 

4 

7 

8 

6 
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Question 2 : Complete : 

To create video clips, follow the following steps 

1-…………………………………………….. 

2-…………………………………………….. 

3-……………………………………………… 
4- ………………………………………………. 

 

Question 3:-Put the following steps in the correct order: 

To Save a project, you should do the following: 

(……….. ) Save the project file in the project Folder. 

(……….. ) Save the project file and name it in English from the Main 

Toolbar, File, Save As. 

(……….. ) Create a project folder on one of the drives and name it in 

English (……….. ) Put all the files ( images, audio, etc..) in the project 

folder. 

Question 4: Complete : 

The program timeline consists of: 

 

 

 

1 
2 

4 

3 
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1-…………………………………………….. 

2-…………………………………………….. 

3-……………………………………………… 
4-………………………………………………. 

 

 

 

 

 

 

 

 

 

 

 

The answer is done through  

Ms Word program “ Answer Lesson Three” file in “ Projects and Answer 

template) Folder 

  

 

 

 

 

 

 

Prepare This for the Next Lesson: 

Stage 4 to design and create a website is the Execution 

stage when the Web pages are created. 

How can you create website pages by HTML? 


